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Welcome to the latest edition of my monthly Final Cut Studio newsletter. This is the issue for December,
2006 and January, 2007.

The goal of this newsletter is to provide information helpful to the professional user of Final
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key
articles are posted on my website for your reference. All software references are to Final Cut
Studio unless otherwise noted.

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 140
tutorials to help you get the most out of Final Cut!

As | write this, we are between Christmas and New Years -- | finally have a few free days to get caught up
on all my work. Hope your time off is enjoyable and the New Year brings you all the projects you can
handle.
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Larry's Power-Up Seminars Coming to England & Ireland

| receive many emails each week asking when my Power-Up with Final Cut Studio seminars are
traveling to Europe. Well, the wait is over -- we are coming to England in February, and we just added a
fourth city to our trip: Dublin, Ireland!

Here's where you can find us:

¢ R =]
. Birmingham - Feb 8 & 9 BHE%EWQLU %

. Manchester - Feb. 12 & 13
. Bristol - Feb. 16 & 17
. Dublin - Feb. 19 & 20

We will also be speaking at several Final Cut User Group meetings during our tour, so keep your eyes on
our home page for our complete schedule.

Based on our North American Fall 2006 Tour, we've updated our Optimize Your Editing with Final Cut
Pro seminar to include HDV, more system trouble-shooting and a more comprehensive workbook.

Then, we created an entirely NEW seminar, Mastering Final Cut Studio, which shows you how to
effectively handle color correction, create hard-to-find color effects, take advantage of the new filters and
effects in Final Cut Studio and discover how to improve your video podcasting.

. Click here for seminar agendas.

. Click here for pricing and venues.

. Click here for testimonials from past seminar attendees.
. Click here to hear me describe what you'll be learning.

We are very excited about these seminars -- they are designed to bring you to the top of your game and
give you lots of new techniques you can apply every day in your editing.

Seats are limited - please be sure to register early. Register before January 1 and save 10% on the
registration price.

Click here to learn more and register. If you have any problems registering, please send me an email.

[Gototop]

Survey: The Business of Editing - 2006
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Our surveys are back and this time, we have something different: | want to learn how your business is
doing this year compared to last year.

All survey responses are completely confidential -- I'll publish a summary of the results next month.

The survey has seven questions and should take less than two minutes to complete -- please take a few
moments and share your opinions. I'd be very grateful.

Click here to take the survey.

[Gototop]

Thoughts on Selecting a FireWire or SATA Hard Drive

One of the questions | get asked in every class is what kind of hard drive a student should buy. For years,
the answer has been FireWire, but, now, things are a bit more complex. So, | want to use this article to
explain why.

FireWire has long been a staple of the video editor - however, there is an inherent limitation with FireWire
which makes it worthwhile to consider other interfaces as you add more gear to your system.

During my recent seminar tour, | was traveling with both a SATA hard drive and a FireWire hard drive
because | wanted to illustrate the differences between the two protocols.

Here are my basic conclusions:

1. Since the two drives cost about the same, if you want the best portability, choose FireWire. If you
want the best performance, choose SATA.

2. If you are using a single FireWire drive, there is no essential difference between connecting it via
FireWire 400 or FireWire 800.

Some Background

Firewire and SATA are both communications protocols used to move data between computers and hard
disks. Over the years, we have had a lot of different protocols -- SCSI, serial, parallel, and, more recently,
Fibre Channel.

The more efficient the protocol, the faster you can get data to and from the hard disk.

FireWire has been available for the Mac for years and has become the format of choice for video editors
because the FireWire protocol efficiently delivers the huge files required.

As a side note, even though USB-2 is supposed to provide even greater bandwidth, don't
use it for video editing on a Mac. It won't work and you will constantly get dropped frames.

However, FireWire has three significant problems:
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1. There are no native FireWire drives -- instead, all data is translated between the hard disk and the
computer using a "bridge" chip.

2. FireWire is a very "chatty" protocol -- drives spend a lot of time talking to the computer and each
other.

3. Firewire is a bus -- the speed of your FireWire devices is often determined by the slowest FireWire
device connected to your computer; most generally, the camera or video deck.

In comparison to the overall hard disk market, the market for FireWire drives is tiny. So small, in fact, that
there are no native FireWire drives. Instead, manufacturers combine an IDE (or EIDE) hard drive with a
bridge chip to translate between the native language of the drive and the FireWire protocol the computer
expects. (There is, of course, other stuff in a hard drive, like power supplies, cases and connectors, but for
the purpose of this example, the hard drive and the bridge chip are what we will focus on.)

This means that the speed of your hard drive is limited, or gated, by the performance of the bridge chip.

There are a variety of bridge chip manufacturers, however, for video there is only one company to
consider: Oxford Semiconductor. They make a variety of bridge chips, the 911 and 922 were earlier efforts

and the 924 is their current chip, that handle the translation between the hard drive and the computer.

The problem is that even the best bridge chips take a toll on data rates to and from the hard disk. For DV
video this is not, generally, a problem. However, as you start to work with the multiple video streams of a
multiclip or move to higher quality formats such as DVCProHD, the data rate of your hard drive becomes
significant.

Here's a short table of some common video data rates:

Common Video Data Rates

| Video Format | Data Rate
IDV & HDV |3.75 MB/second
IDVCPro-50 |7.5 MB/second

IDVCProHD |15 MB/ second

[Beta SP (Uncompressed 8-bit) |20.2 MB/second
|DigiBeta (Uncompressed 10-bit) |26.7 MB/second
|1080i HD (Uncompressed 10-bit) |~150 MB/second

Another problem with FireWire is that the computer and hard drive spend a lot of time talking to each other
in the background, making sure they are still connected and exchanging other pleasantries which have
nothing to do with your data. With one or two hard drives, this isn't a problem. However, | have seen
significant speed slowdowns with as few as five hard drives attached to a G-5.

In other words, the more FireWire drives you add to your system, the more things will slow down. For this
reason, | recommend that you are better off buying a RAID if you need more storage, and not just add
more and more FireWire drives to your system.

For me, the practical limit of FireWire drives connected to a G-5 computer is five. Final Cut
will support up to 16.

FireWire Speed Tests
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To illustrate what I'm saying about FireWire speed, | recently compared the speed between the ports of a
G-Tech FireWire drive which had both FireWire 400 and FireWire 800.

First, let me say that this G-Tech drive has been schlepped all over the world during the last year -- well
over 75 plane flights all over the US, Canada, and Australia. | have never seen a more rugged, or quieter,
drive.

Here are the results:
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The image on the left measures the speed of a hard drive connected using FireWire 400, on the right is
the same drive on the same computer connected using FireWire 800. The only difference between these
two tests was how | connected the hard drive to the computer. The tests were run about five minutes apart
and the drive was about 60% empty. (The key numbers to look at are for "Combined," and, yes, in this
example, FireWire 800 is slower.)

There are several factors that determine the speed of a hard drive:

. All hard drives access data faster or slower, depending upon where the data is located on the hard
drive (Inner is faster).

. Hard drives generally write (record) data faster than they read (play) it.

. The fuller a hard drive, the slower it goes.

Notice that in this example FireWire 400 writes faster than FireWire 800 and that the read speed is
identical. Why? Because the speed of your FireWire hard disk is dependent more on the speed of the
bridge chip than it is on the how the drive is connected to your computer.

Getting to Know SATA

SATA is a new protocol that rose to prominence with the release of the G-5, because SATA is the default
hard disk protocol for the G-5 and all Mac/Intel systems.

The good news is that SATA is fast, very fast. The bad news is that SATA requires a PCI card for your
laptop or tower; and because it needs a card, it won't work on a MacBook or iMac, neither of which have a
slot to install the card.



Many hard drive manufacturers are selling SATA drives. Maxtor makes an internal drive for the MacPro, G-
Tech, LaCie, CalDigit, OWC and others make external drives. (See the story below on my testing of a

CalDigit system.)

PCI cards are available for both MacBook Pro and MacPro systems from Sonnet, ProMax, LaCie, and
others. However, be careful. | recently purchased a SATA hard drive from LaCie which uses a SATA
connector that only works with a LaCie PCI card. This prevents me from moving this hard drive to any
other computer, because the used cable to connect it is non-standard. You are much better off buying the
card from Sonnet and a hard drive from a vendor that supports the standard SATA plug to prevent getting
locked into a proprietary cabling system.

SATA Speed Test
Let's compare the speed of the SATA drive to the FireWire drive.

Important note: These stats compare two different drives, which are not exactly
comparable. Your numbers will vary, though SATA will always be faster.
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In this example, the SATA drive is on the left, FireWire 800 is on the right. When we look at the Combined
results, the SATA drive is 2.3 TIMES faster than the FireWire drive. This is a significant performance boost.

Note: These tests used a MacBook Pro Core 2 Duo. If | ran the sames tests on a MacPro,
the FireWire numbers would be essentially the same and the SATA numbers would be
closer to 150 MB/second in Combined throughput. G-5's would be slightly slower.

Conclusion

On my system, | have a SATA drive, a two-drive RAID actually, that | use as my scratch disk for all my
editing. Then, | have a second, FireWire, drive that | use to move files from one computer to the next.

As | said at the beginning, if portability is your prime concern, FireWire is the best choice. However, if
performance is more important, and you don't need to move drives from one computer to the next, my
strong recommendation is SATA.



Update - 12/29/06
Long-time reader, Andreas Kiel wanted to clarify something | wrote:
[The problem with FireWire speeds is] Apple's implementation of the FireWire bus structure.

Unibrain for example had a product for TCP/IP over FireWire which especially did shine with
heavy loads and outperformed 1G Ethernet with a FW400 connection, since FW isn't chatty.
Also in surveillance FW is loved since you can put a real lot of cameras to the bus without
slowing down the speed.

With third party FW800 cards in a desktop machine you get a way better performance than
with the integrated ports. | haven't tried portables.

Larry replies: Andreas, thanks for this additional information.

[Gototop]

Reviewing a CalDigit 500GB S2VR Duo SATA RAID

| am not a testing organization, but, recently, Jon Schilling over at CalDigit (www.caldigit.com) sent me a
500 GB SATA RAID to examine (Model #S2VR Duo).

As you read in my earlier article, I've been a fan of SATA for a while, and was looking forward to seeing
how well this matched up with my expectations.

However, since | also recently upgraded from my trusty PowerBook G4 to a new MacBook Pro Core 2 Duo
there were no SATA cards that worked with my new toy. Sigh... things needed to wait. Then, about a
month ago, CalDigit had both the RAID and a brand-new ExpressCard that supported my MacBook Pro, so
they shipped me both.

This two-drive RAID arrived and was quickly unpacked. It weighed in at 7.5 pounds, stands about 5 inches
high and has a nice brushed aluminum case. It only held 500 GB, but that was by my choice, | didn't need
anything bigger for my review. (The maximum storage for this unit is 1.5 TB. Pricing starts around $450.)

| set it on my desk long enough to reformat to Mac OS Extended (I turned Journaling Off) and get all the
drivers installed. However, my plane was leaving in about four hours and this hard disk was needed for the
trip, so | did what any normal editor would do, | wrapped it in a bath towel, stuffed it in my suitcase, and
headed for Orlando. (My feeling was that any hard disk can sit on a desk -- | wanted to see how well this
would work on the road. And, in short, it worked great.)

That hard disk, and its bath towel, traveled with me as checked luggage to Orlando (four flight segments),
Nashville (four more flight segments), and Honolulu (two flight segments). It worked perfectly every time.
Here are the data transfer specs, as measured on my MacBook Pro Core 2 Duo:
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| discovered that using the ExpressCard did not allow the drive to perform as fast as if it were connected to
a Mac Pro. According to Jon this is a limitation of the ExpressCard drivers:

"90 - 105 MB/second is about right with the MacBook Pro. For fastest performance [up to
150 MB/sec] you will always be faster with your MacPro tower."

Near the end of December new drivers were released for this card, but | haven't played with them, so |
don't know if the speed has changed.

Conclusion
Three things impressed me about this unit:

1. It's speed -- SATA really is fast
2. It's ruggedness -- this got manhandled in several cities and held up great
3. It's simplicity -- two cables, one installation disk and you're ready to run.

There is only one thing | don't like about this unit -- it's fan noise. | do a lot of audio recording for demos
and podcasts. | can't leave this unit running during the recording -- it's way too noisy. It isn't bad when you
are editing, but | find it distracting.

Update: Upon reading this review, Jon Schilling at CalDigit, did some digging and wrote:

"Unfortunately after checking the serial number of the unit we sent you we realized that you
got a unit with one of the older fans that we used initially. We have since remedied the ‘'loud
fan issue'. Sorry that you got one of the older units."”

Jon tells me that all products now ship with a quieter fan, using an in-line resistor. So, from my point of
view, if you want speed in a rugged enclosure at a reasonable cost, this SATA RAID from CalDigit is
definitely worth considering.

[Gototop]




Quick Tip: Best Ways to Scale an Image

Scaling still images is an essential technique to get the best visual quality. (And here's an article that
explains how to get your images looking great.)

However, when it comes to quality, the default scaling settings in PhotoShop are not the best to use. In
fact, | was reading a recent issue of PC Photo and discovered this interesting tidbit:

— Document Size:

Width: |3.972 “inches 44

, Jo
Height: |3.257 _inches 3]
Resolution: |72 :pixels,n’inch I--H

Mearest Neighbor
Bilinear
Bicubic

v Bicubic Smoother

Bicubic Sharper

W Scale Styles
E Constrain Proporti

™ Resample Image:

When using PhotoShop to scale an image, don't use the Bicubic default. Instead, if you are scaling an
image to be larger, use Bicubic Smoother. If you are scaling an image to be smaller, use Bicubic Sharper.
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Here is the same image, scaled two different ways. The image on the left is scaled using Bicubic. The
image on the right is scaled using Bicubic Sharper. | like the look of the image on the right.

[Gototop]
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Special Offer: All 2006 Newsletter Back Issues Now Available

Available now, all twelve issues (including this December issue) of my monthly newsletter -- over 410
pages of tips, techniques, and reader questions -- all on one CD-ROM.

These 12 PDF files contain more Final Cut Studio information than
anywhere else on the planet -- instantly searchable and at your
fingertips when you need it.

All twelve issues for only $29.95. Plus, for the first 20 people J(Jl‘dal“l
that order, I'll include a second FREE CD containing all the 2005
back-issues -- another 350 pages of great tips and techniques. Be A SEOCIATES
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Order your copy today -- when it's four-o'clock in the morning
and you really need the help, you'll be glad you did. Larry Jordan’s
Final Cut” Newsletter
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Technique: Creating Trail Effects
Marcia Orland started me thinking about a new filter in Final Cut Pro 5.1.2 -- the Trails filter. Marcia wrote:

| have a video travelog I'm cutting for a client. He's seen an effect (on Playboy Channel!)
where a girl is walking, and you see multiple superimposed images of the girl which makes it
look like her stride is moving in a blurred stutter. Because his footage is all polar bears, he's
looking for that effect when they're walking, to make it more interesting. I've stacked 3
identical video cuts of a bear walking, offsetting each by just a few frames, and reduced the
opacity on each track. But it doesn't really look cool. It looks more like a mistake.

Is there a tool | can use to accomplish the effect (if you can understand it from my
inexperienced description)?

Larry replies: Marcia, many of these trail effects that your client saw on the Playboy Channel, or others
may have seen on Monday Night Football, involve software other than Final Cut Pro.

However, with the release of Final Cut Pro 5.1.2, over 50 new filters were released, along with the
transition of FCP to support both the FXScript and the FXPlug effects architectures. One of these filters,
called "Trails," may give you the effect you want.

Note: There are additional filters in Motion that can be used. At the end of this technique, I'll
show you two of them -- Wide Time and Echoes.

The video that works best for this effect has a high degree of contrast between the background and the
object in the foreground you want to create trails for; polar bears in a snowstorm will be difficult, though you
could trail their noses or paws. In this example, we have a dark snowboarder on a light background of
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snow. Here's how to create the trails effect.
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Video

2. Load your clip to the timeline and apply the Effects > Video Filters > Time > Trails effect. (This filter
first appeared in Final Cut in the 5.1.2 release, though it existed in Motion prior to that.)
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Echoes

Decay
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3. While each image will require different effect settings, here's some ideas. Duration controls how far
back in time the trails will exist. Echoes determines how many images will "trail after" the source image.
Decay has images fade over time or, if unchecked, has them remain at full intensity. Trail on determines
whether you are trailing a light image on a dark background or, as in this example, trailing a dark image on
a light background.

01:00:00:23 ||

4. Here's the finished effect. Notice that the lead image is dark with copies of the image trailing after it.
Variations in Motion

There are two other effects which create variations on this effect, but they are only available in Motion.
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The Wide Time effect (Filters > Time > Wide Time) creates much more closely spaced echoes of the
moving object.

The Echo filter (Filters > Time > Echo) has an opposite look to the Trails filter. It creates faint images
which precede the main image, rather than follow it, as the Trails filter does.

Whichever effect you use, the key is to make sure there is plenty of contrast between the foreground image
and the background. If there is, you can create some very cool effects.

[Gototop]

Dealing with Timecode Breaks in Multiclips

Here is an interesting puzzle, contributed by Gene Thomas:



| am editing a two camera shoot of a two hour opera. hence, two 2-hour reels. For some
reason, while logging and capturing, camera 1's segment, the WS, was broken into two
pieces, of 1 hr something; and about 40 minutes.

| created a multiclip using the complete cam 2; and the long part of cam 1.

My editing has proceeded along fine. However, when | reached the point where there was a
break in the logged clip (cam 1), | discovered that some of the material from cam 1 had been
dropped out in the 2nd clip.

On the timeline | edited in cam 2 to fill that whole, and then attempted to continue with a 2nd
multiclip (of cam 2 complete, and cam 1 partial). For some reason | can't seem to get the
whole process to work again. Is what | attempted possible?

In my email reply to Gene, | first explained that | didn't know why his clip stopped capturing in the middle -
obviously, there was a timecode break in the tape for some reason.

Multiclip assumes that all clips have continuous timecode and that all clips are continuous, that is, they all
start and stop at about the same time.

What | suggested then was that he create is a Multiclip Sequence. This allows him to place multiple clips in
the same sequence where each clip has a significantly different timecode from other clips. An analogy | like
to use is multiple cameras along a parade route. Each camera starts and stops at a different time as the
parade gets to that location.

This would allow you to build a single multiclip containing all three clips. The only requirement -- and it is
significant -- is that the timecode would need to match between all the cameras. However, this can be
resolved by manually changing the timecode in the second clip he captured from tape 1.

At that point, | steered him toward an article that illustrates how to change timecode:

Working with Auxilliary Timecode

Gene then wrote back:

| have one question: once you create the multiclip sequence, do you then simply put it into
the timeline, just as you would a multiclip (e.g.: overwrite, etc.), and then proceed to edit it in
the same manner? That's not clear to me from your Final Cut Pro 5 book, which doesn't
focus on that.

Also, I'm not sure | understand what you mean by "manually changing the timecode." do you
mean aligning it within the mc sequence, or somehow changing it? | think this must be
obvious, but not to me at the moment.

There's no rush on this; | successfully finished cutting the show last night. but your advice
will greatly enhance my understanding.

Larry replies: Gene, these are all good questions. And, in thinking about this further, | have a better idea.
There's an easier way to solve this problem than creating a multiclip sequence.
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What you need to do is create two multiclips: Multiclip 1 contains the first shots from both cameras, while
Multiclip 2 contains the first shot from camera 2 and the second shot from camera one.

Here's one way to solve this problem.

. Capture both cameras and make sure the shots are displayed in the Browser
. Control-click on the long camera 2 shot and duplicate it

. Set a common In for the first camera 1 shot and the long camera 2 shot

. Create a multiclip of both these shots and edit normally

Here's an article that describes how to create a multiclip: Setting up a Multiclip

To determine where this second multiclip starts:

. Seta common In at the beginning of the second camera 1 shot, then find the same point on the
duplicated camera 2 shot and set an In there, as well.

. Create a second multiclip

. Edit that to the timeline, starting where the first camera 1 shot ended

By using two different multiclip shots, you would be able to edit smoothly from the end of the first camera
one shot to the second. Using multiclips with a common In, means that you don't need to worry about
setting or changing timecode.

[Gototop]

A Sad Story About Using Multiclips

A reader, who will remain nameless, sent the following sad story, which | have somewhat edited to save
space.

My computer and | were hired to edit a series of shows using multiclip. However, to save
hard disk space, we decided to digitize the footage using Photo-JPEG, rather than DV.

However, Photo-JPEG images are only 320 x 240, too small to see well in the Canvas. So
we made them bigger. The problem is that, according to Apple, a multiclip does not play
Photo-JPEG images in real-time unless they are 320 x 240 in size.

So, after a lot of work and phone calls, "my computer and | got let go. It turns out that Final
Cut cannot have playback in Multicam mode when you are using the Photo-Jpeg footage."”

Larry replies: First, I'm sorry this didn't work out. So, in an effort to make lemonade from lemons, there are
a number of lessons we can all learn from this.

First, ALWAYS test a new technology to make sure it works before spending lots of time capturing footage
that, ultimately, can't be used.

Second, the amount of hard disk space you saved by using Photo-JPEG is not worth the aggravation when
compared to DV. Multiclip works great for DV. For the price of a larger hard disk, the job was lost.
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Third, smaller files sizes always come with a price -- reduced image quality, image size, or color
information. Be sure you understand the trade-offs before committing to a format.

Finally, this was not all your fault. The director decided to use multiclip after the footage had been digitized.
Which points out the last lesson -- it is far easier to accommodate changes before footage is digitized than
after. It is critical to get the producer or director to explain what they want to do as early in the process as
possible. This will prevent these sorts of problems from recurring in the future.

UPDATE - 12/28/06
Mark Raudonis wrote in to offer a different perspective:

While | agree with your responses in general, you leave the impression that "off-line RT or
PhotoJPEG" isn't worth the trouble. On that point, | have to disagree. | work in reality TV. We
regularly generate thousands of hours of coverage for a season's worth of shows. While we
do have a fairly large amount of storage (45 terrabytes), it wouldn't even come close to being
enough if we worked at DV resolution. So, we use "Off-line RT" for all off-line work and then
do the classic "on-line" conform. Furthermore, by using such a low resolution, we can "tap
in" to our X-SAN over plain old gig e... something that would NOT be possible if we were
trying to use DV.

This one decision (work at off-line RT) enables us to tie our story departments into the X-
SAN. They now can access the original media using IMAC's (or even PC'S!) over cat 6
cable. Our goal of inviting "everyone into the pool" works and works well. I'm not sure what
your "nameless" reader means by "too small to see in the canvas". On our desktops, the
images are the exact same size as other resolutions, just not as clear. We use multicam
clips all the time. They playback just fine without needing to render. The problem your reader
has is that it seems like they're blowing them up in a misguided effort to see them better.
This is just plain stupid!

As you point out, there is no "free lunch". Low bandwidth comes at a price. However,
knowing the tradeoffs, I'll take access and workflow over pretty pictures any day.

Larry replies: Mark, these are all good points. Thanks for sharing them.

[Gototop]

Updated Ruling on Copyright and DVD Security

For you teachers out there, Eric Swelstat, media department chair at L.A. Valley College, sent me the
following:

Copyright Office Eases Rules on DVD Security

The Library of Congress's Copyright Office on Wednesday (Nov. 22, 2006) granted an
exemption to film professors, allowing them to break the copy-protection codes on DVDs in
order to create compilations of movie clips for their classes.


http://www.lavc.edu/

Although such compilations are permitted under "fair use" interpretation of the copyright law,
breaking the CSS security code is not. Studios had argued that the professors could use
VHS tapes of the same films, but the professors countered that such tapes are often not
available and those that are lack the quality of the DVDs.

The ruling -- along with others dealing with copyright law handed down by the Copyright
Office on Wednesday -- was welcomed by the Electronic Frontier Foundation, a consumers'
group, but Fred von Lohmann, an attorney with the group, commented that he was
disappointed that the office had rejected a petition that would have allowed owners of DVDs
to copy their movies on the iPods and other portable players.

[Gototop]

New! Color Correction Training DVD Now Available

In conjunction with Lynda.com, my latest Final Cut training DVD -- Learning Color Correction
Techniques -- is now available for $99 in our on-line store.

Over six hours of narrated Quicktime movies, plus sample images and exercise files, this DVD really
shows you how to improve the color of your projects.

The title includes tutorials on:

. Learning how to read video scopes
. Understanding color terminology

. Correcting image contrast

. Automatically correcting color

. Adjusting color by comparing clips
. Manually correcting color .

. Correcting portions of an image F]I"Ial CUt Pm 5

. Changing time of day and other color effects

In the DVD you watch as | show you how to create these COLGR CORRECTION

effects, then, use the included exercise files to practice these same
techniques for yourself.

I'm very proud of this title and | believe you will enjoy it as well. b e g

Click here to order -- plus, order any TWO titles before VIDED TRAINING r
the end of 2006 and we will pay the shipping! I e lynda.com
[Gototop]

Calibrating a PAL Video Monitor
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Steve, from Australia, writes:

Thanks for your newsletters. Here's a question that I'm hoping some of your European
readers might be able to help me with.

How exactly do you calibrate a PAL monitor with the FCP colour bars? There are many
tutorials on how to do it with NTSC, but | can't find any information on how to do it with PAL.
And I've had a really good look on Google.

| have a JVC TM-H160CG reference monitor - 15" and with Blue gun [able to be isolated].
Using NTSC footage, sequences and colour bars and putting it through my camera switched
to NTSC, | am able to calibrate my monitor successfully and the footage looks great.

For your info: Brightness + 4, Contrast + 4 (tricky this one), Chroma 0, Phase 0.

But using the FCP PAL bars in PAL sequences, its quite nuts. | want to raise the Chroma to
+ 30, and similar for Brightness.

Not only is the last bar 100% white instead of 75%. But the PAL PLUG bars register
differently in the waveform monitor than do the NTSC bars. In NTSC the Plug are say +5
and -5, while the PAL Plug are +1 and -2.

So obviously there must be another system for PAL. My answer at the moment is to use the
same monitor settings for PAL as | calibrated for NTSC. (Brightness and Contrast up 4). And
frankly the footage looks pretty good. But | would really like to know if there's a more exact
and scientific method to do it, and I'm hoping you'd be able to help.

Larry replies: Steve, I'm not a PAL engineer, so I'll throw this open to our readers to see what they suggest.

UPDATE - 12/29/06
Sven Pors, of TV-Glad, Copenhagen, helps answer this question:
| have used these mixed but common methods of setting up PAL monitors for years.

Choose the EBU 100% standard "PAL full-frame bars" from FCP

=

Turn color, contrast and brightness all the way down.
Turn up brightness until you see the black bar just start to light up.

N

3. Turn up contrast until the bars display an even grayscale - not including the 100% white bar. This

bar should not be glowing (turn up until the white bar doesn't get brighter then pull back a bit).

4. Turn up color until the red bar is fully red but not glowing. On monitors with "blue-only" the 3 bars to

the right should be equal shades of blue.

5. Test and maybe fine-tune using a real picture you know has full color information and dynamics.

This means good saturation, blacks, whites, low and high mid-tones.

Or in short:
Turn down everything. Turn up brightness. Turn up contrast. Turn up color.

Note: If the lightning conditions around your monitor changes (day/night) you need to adjust
the brightness to get good blacks and low mid-tones. Ideally this means daily if your



workingplace is near a window...

On some cheaper/older monitors brightness and contrast affect each other and you may
have to repeat steps 1 and 2.

If your monitor does not have a blue-only feature, you can look at it through some layers of
blue filter normally used for lamps at theaters.

Major broadcasters sometimes get their reference monitors callibrated using measuring
probes and some kinds of software or oscilloscopes. The contrast and color levels used are
lower than for consumer televisions.

Some use other test-signals from a signal generator or from a picture file to set up their
monitors.

In FCP the current PAL full frame bars are 100% bars (luminance level). Using 75% bars
(currently not present in my FCP) slightly alters the method above.

In the living room (without a color bar):

. Use brightness to get best details in the lows.
. Use contrast to get most definition in the highs.
. Set color at will but not too high

Larry replies: Sven, thanks for taking the time to write. This is very helpful.

[Gototop]

Shooting NTSC to go to PAL

Last month, Matt Pennington asked what was the best way to go from NTSC to PAL. Thomas Fritscher,
from Germany, responded with:

From my experience, 30p is the worst way to shoot if you're going to PAL, unless you want

your footage to run significantly slower in PAL. This is because there is half as much motion
information recorded compared to 60i which makes it harder to interpolate the frames to go

to 50i.

If you don't mind the 4% speed up | would recommend shooting in 24pA (the "A" being
important!), remove the advanced pulldown, conform the footage to 25p using Cinema Tools
and then importing into a 25p PAL sequence to resize to 720x576. This will give you very
good quality 25p PAL which is 4% faster than the original, but since no one knows the
original, hardly anyone will notice.

If you don't want the 4% speedup, or need interlaced video, shoot 60i and use Nattress or
Compressor 2 to convert to PAL.

| forwarded Thomas' comments to Matt, who wrote back:



Very interesting, I'm glad | didn't go with 30p like | had originally planned!

But | took your advice and just shot 24p (not 24pA) and I'm sending the master to a local
place to convert to PAL. Because I'm doing this for a contest | want it to look the best it can -
and I'm at least happy to say we shot the remaining footage this past weekend and the
rough edit is looking good. By the way, the Gradient Wipe is my best friend.

Thanks again Larry.
Larry replies: Thomas, thanks for writing and, Matt, you're welcome.

[Gototop]

More PAL Questions
Jeffrey Abelson writes:

I've never worked in anything but NTSC DV, and need to start work immediately on a music-
video for an English band who's sent me a bunch of PAL tapes.

| gather I'd be better off with the Nattress standards conversion filter (rather than relying on

FCP alone), but | need to understand the best workflow that will enable me to edit the film in
FCP 4.5, then output both as a PAL master and an NTSC master, and have them both look
right.

I've read about how conversions speed up or slow down the program. | cannot live with that.
This is a music-video, where the audio cannot tolerate any variance in speed whatsoever --
but also, the video will be cut very aggressively to the beat, so | can't edit it to my rhythmic
satisfaction, then have the picture speed up during a conversion such that it no longer
represents the very precise rhythmic editing choices | made.

So.... | need a general overview of how best to convert standards, and during what part of
the workflow -- given the music-video nature, and given need to have a final product in both
standards that isn't speeded up/down, and doesn't have weird anomalies.

Larry replies: Jeffrey, it is FAR easier to convert from PAL to NTSC, than to go from NTSC to PAL. Since
the band sent you PAL tapes, my recommendation is to capture, edit and output PAL; first to a PAL video
tape to send back to the band, then to a self-contained QuickTime movie for conversion to NTSC.

Then, using either Graeme Nattress' Standard Converter (www.nattress.com) or Apple's Compressor,
which ships with Final Cut Studio, you can convert that QuickTime movie into an NTSC QuickTime movie
which you would then import into Final Cut for output to NTSC video tape.


http://www.nattress.com/
http://www.nattress.com/
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To convert your QuickTime movie from PAL to NTSC using Compressor, drag your movie into the Batch
window, then select Setting > Advanced Format Conversion > DV NTSC (for 4:3 images) or DV NTSC
Anamorphic (for 16:9 images).

Allow PLENTY of time -- Compressor can take hours for the conversion. Nattress is much, much faster.

[Gototop]

This Month in Edit Well

Here's what's in the December issue of Edit Well, the rich-
media newsletter for Final Cut Studio:

. Motion's Open Secret - The Power of Parameter
Behaviors

. FCP Rescue vs. FCP Attic - Which is Right for You?

. Making Audio Magic with Soundtrack Pro's Match EQ Filter

. Scripting Subtitles, Audio and Angles in DVD Studio Pro

. Removing Pulldown Frames with Cinema Tools

. Trashing Final Cut Preferences

. Presetting Streams in DVD Studio Pro

. Understanding Cadence and Pulldown

. Avideo tutorial on how to use the Match EQ filter

. And audio interviews with two Final Cut editors - Bill Buchanan and Sharri Weinberg

Edit Well this month is 41 pages of Final Cut Studio video tutorials, audio interviews, techniques, keyboard
shortcuts and tips that you just can't find anywhere else. In Edit Well, you don't just read about it.. you
watch and listen to it. And, at only $59 per year, this is a GREAT deal!

Click here to subscribe: www.peachpit.com/editwell.



http://www.larryjordan.biz/nxltrs/www.editwell.com
http://www.peachpit.com/editwell
http://www.peachpit.com/editwell

I've been teaching, researching and writing about Final Cut for years -- there's nothing like Edit Well; not in
print, not on the web, and not in the classroom.

Edit Well is published by Peachpit Press and a subscription is only $59.99 per year -- and well worth it. If
getting the latest in tips and techniques is important to you, take a few minutes and subscribe to Edit Well:
www.peachpit.com/editwell. If you have any problems subscribing, send me an email.

[Gototop]

Technique: How Soundtrack Pro Handles Mono and Stereo Files
This started with a nice letter from Peter Helenius, who writes:

First let me say that you do a great job for Lynda.com. However, | came across one issue
that you did not mention. When exporting a project from FCP to STP there is a big difference
on how STP deals with mono clips.

If your FCP project is in Link mode (MODIFY/LINK) the mono clips are in one channel only.
If your project is not link(ed) the mono tracks come in on two channels. This took a while to
figure out.

The mono portions of my project would show as stereo clips in FCP allowing for left and right
panning for effect. When using send to multi link project into STP there was only one
channel displayed which did not allow me to pan to the other channel at all. It was not until |
turned off the link feature in the FCP modify menu that | was able to play with the sound as |
wished to.

Larry replies: Peter, you are right that STP does not handle mono clips the same as stereo clips. However,
your understanding of what the Link function does and how STP handles these different clips is a bit off, so
let me explain further.

Mark BUICEOVE Sequence Effects Tools

Make Subclip 38U
Remove Subclip Limits
Make Independent Clip
Make Freeze Frame 1N
Merge Clips...

Scale to Sequence

v Clip Enable

v Stereo Pair
lin Settinns
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What Modify > Link does is connect, or disconnect, the link between the audio and video of whatever
synced clip, or clips, are selected. By default, a synched audio/video clip is linked.

This means that if you move the video without moving the audio, Final Cut will display a red flag indicating
the clip is out of sync.

Move into Sync
Slip into Sync
Move Others into Sync

Slip Others into Sync

Note: To move clips back into sync, Control-click on the red flag of the clip that is out of
sync and select Move into sync.

But, | digress...
Soundtrack Pro pays attention to the link status of a clip when it receives a clip sent from Final Cut:

. If the clip is @ mono clip, it is assigned to it's own track.

. If the clip was captured or imported as stereo, it is assigned to a stereo track.

. If two clips were mono, but are then linked to become a stereo clip, they areassigned to two mono
tracks.

- 01:00:38;29

BEATS

This illustrates that a mono clip with no panning remains a mono clip.



01:00:46;16

EEATS

This illustrates that a mono clip with panning is converted, during import to STP, into a stereo pair with the
same audio on both tracks.

- 01:00:00;00

EEATS

This illustrates two clips that were captured mono, but were then linked into a stereo pair are converted to
two mono clips on two separate tracks.



- 01:00:56;27

EEATS

This illustrates that only clips that were captured as stereo show up as a single stereo clip in Soundtrack
Pro.

Thanks for writing. | enjoyed the chance to think this through a bit more clearly with you.

[Gototop]

A Simple Question of Linking
Pete Hoare writes:

This may seem like a really stupid question, but | cant for the life of me work out how to de-
link linked audio and video in FCP?! | have been scraping by for a while by locking either the
video or audio track, then dragging the other away. This works but its not very elegant.

If you could help me out, | would be very grateful.
Larry replies: Easy. Hold down the Option key and click the portion of the clip you want to select.
Never lock tracks. Locking is for the weak.

[Gototop]

Sending Audio to ProTools and Back Again Using OMF
Bill Darst writes:

| have a project edited on the standard FCP, G5 2.0 dual processor. A friend at a
professional audio mix-down facility offered (free) to have sound effects and an audio mix
done in Pro Tools. | had exported my audio mix to OMF, (not knowing at the time OMF files



couldn't be loaded back into FPC.) So | brought my hard drive and he loaded it onto his
Power Mac laptop.

They were able to open my FCP files, and saw the dialog box saying this is a different
version on the dual core universal version. They made a copy and 'saved it as' so they could
work on the project. He was able to see my old project file, and had access to my audio and
video media. Anyway all turned out well until it was time to go back to my original version in
my G5.

When | tried to open his project on my version of FCP just says there is a ‘General error...'
and will not have anything to do with the universal version. Is this normal or is there a
backdoor trick? The solution to not being able to import OMF files was to bounced the tracks
down and make them into AIFF files. Which created the second weird thing. The result of the
converted AIFF files came out AIFC. This in turn creates the red audio render line when
placed in the timeline, which at first isn't a problem, but each time an adjustment is made on
the audio track, the whole audio track has to be rendered again.

So | drag the AIFC file into iTunes and converting it to an audio file that said AIFF, then it
goes on the timeline without any rendering.

My question is can | go back and forth between versions on my non universal G5, and or
could an XML file be created on the universal side and brought over to my side so | would
have all the data of the universal mix and could work with it on my side? And why when |
export 'to AIFF files', from my own FCP timeline, why does it come out as AIFC files and
what the heck is an AIFC file anyway.

Larry replies: Wow. There is a whole flock of questions in this message. Let's tackle them one at a time.

First, here's an article that describes how to move your audio files from Final Cut to ProTools using OMF.
It's easy -- just remember that the files leave FCP using OMF, but they must return to FCP as an AIFF file.

IEN edit  Audiosuite MIDI  Movie Op

MNew Session... 3t
Open Session... 3t ()
Close 5ession it 36 W
Save Session 35

Save S5ession As...
Sawve Session Copy In...
Revert to Saved...

Bounce to Disk...

Mew Track... {r3EMN

Second, to get your audio back into Final Cut, you will need to use File > Bounce to Disk in ProTools to
create an AIFF file (generally a stereo pair). Then, import that AIFF file into Final Cut and edit it to your
timeline.

Third, you can not move projects between versions of Final Cut Studio. FCP 5.1 is required for all Intel-
based Macs. Based on your message, you are running FCP 5.0x. The "General Error" message is your
warning that you are moving between versions. While you could use XML to move back and forth, a much


http://www.larryjordan.biz/articles/lj_OMFexport.html

better option is to upgrade to version 5.1.2 of FCP.

There are some solid bug fixes and new features that make this upgrade worthwhile. Plus, you'll be able to
open the projects that are modified by your audio house with no problems. Click here to go to Apple's
website to learn more.

[Gototop]

New Product: Final Cut Pro Keyboard Covers

One of the most popular products we showcased
during our recent tour were Final Cut Pro keyboard &
covers, created by KB Covers, specifically for
laptops!

The covers are made of durable, flexible silicone (0.5mm thin) and perfectly molded to fit both the
Aluminum Powerbook G4 (127, 157, 17”) and the MacBook Pro (15”7, 17”). They will not slip or slide. In
addition, the covers have a silky smooth feel so they are soft and comfortable to the touch and will not
restrict typing.

Utilizing a 9-color printing process, the editing keys are color-coded and heat fused to ensure long lasting
durability. KB Covers also safeguards your keyboard from dirt, spills and wear and tear, allowing you to
protect your investment in your notebook computer.

Click here to learn more.

[Gototop]

READER MAIL

Time now for Reader Mail -- and, as usual, we have a ton, so let's get right to it. (By the way, feel free to
send me your comments and questions. | love hearing from you.

Contents
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Media Manager Tip
Lee Berger writes:
Here's a tip that your newsletter readers might find useful.

Today | was legally importing media into FCP from a client's DVD using MPEG Streamclip.
The media was saved as a DV Quicktime Movie. The 13 minute program consists of
graphics, b-roll and interviews. I'm was only interested in the B-Roll, so | subclipped what |
wanted, and then went to eliminate the rest using the Media Manager's copy function (I
always copy, verify, and then delete the original media). | couldn't get MM to recognize only
the subclipped sections of the media. The Original and Modified amounts were the same.
I've done this many times with large captures from DV and Beta so you can imagine how
perplexed | was.

| verified that the original clip was not included in my selection of subclips. | then noticed that
all of the subclips had the same timecode in the Media Start Column, 00:00:00:00. |
surmised that the DV Quicktime Movie did not actually contain SMPTE timecode. So |
modified the original clip's source timecode and voila. Now the subclips had different
timecodes in the start column. | selected the subclips, opened MM and sure enough the
Modified media amounts were smaller.

Larry replies: Very cool. Thanks for sharing. Here's an article that explains how to modify timecode.

[Gototop]

Problems with Timecode
King Dexter, from somewhere near Denver, writes:

Well, it finally bit me. I've been so lucky all this time, but - the time code break gremlin finally
found me. | suspect that powering the camera on and off (even previewing some of the
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footage in camera) is at the root of the problem. Don't know for sure. Anyway, as |
scrambled and searched for information on the subject | noticed that | couldn't find a lot of
information in any one place as to good steps to take to prevent the problem. Or, maybe |
just didn't look in the right place.

| for one would be interested in a list - if possible - of wise preventative steps to take to avoid
time code breaks. As you know, most of my work is with DV and not hi-end (if that makes a
difference). | typically stripe my tapes (using FCP). | do like to capture what I've shot at the
end of each day or so of shooting and then continue picking up where | stopped the day
before. Is this a risky thing to do? Is it really important to try and find the exact time code
location where the previous day's shooting ended before continuing the shoot? Etc.

Larry replies: King, it is good to hear from you again.

First, for those that don't know how to record timecode on their tapes (called "striping"), here's an article
that explains how.

Second, not all cameras are able to pick up timecode if you run past the end of recorded material. The
more expensive the camera, the better it does at finding timecode.

There are really only two suggestions for avoiding timecode breaks:

1. Timecode breaks occur when you review a tape after recording and stop after the recorded section
2. Therefore, to prevent timecode breaks, always be sure to rewind the tape back into the recorded
portion prior to starting recording again

Striping tapes can help prevent this problem, but doesn't always work because low-end cameras don't
reference timecode on the tape when they are recording, but, rather, regenerate it from an internal
timecode generator.

So, the best rule is to rewind your tape back into the recorded portion, then. ALWAYS give yourself ten
second handles after you start recording before essential action starts.

[Gototop]

Over-modulated Audio
Janine Elgamal writes:

[1] have some audio that is over-modulated ... pops really loud at one point where the subject
was yelling at the top of his lungs. So | took the audio into Soundtrack, ran it through the
Analyzer, and it detected the pop. When | ran Fix All, it didn't correct it.

Larry replies: Janine, over-modulated -- that is, distorted audio -- can't be fixed. It was destroyed at the
moment it was recorded to tape. The best thing is to re-record it. For this reason, it is critical that when you
are recording audio, keep your levels a bit on the low side. It is easy to increase the volume in post, it is
impossible to fix it once it is distorted.
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[Gototop]

Missing Render Files
David Black, from Malden, Missouri, writes:

| got your wonderful newsletter and it's chock full of good articles. Question: | lost some files
and found them under the render manager after reading an article you wrote about "render
manager". Can this file be used again?

Larry replies: Sure. However, if it was only render files that you lost, you are better off choosing Sequence
> Render All and re-rendering. This is both faster and you make sure that all your render files are looking
their best and are properly connected.

By the way, here's the link to the article.

[Gototop]

Problems with Ultimatte
Allan Gruber, from Canada, writes:

| didn't have a chance to read last month's newsletter, but a question with regards to the
Ultimatte software. Since we switched to the Intel Macs the Ultimatte software (since it's not
universal binary) doesn't work for us anymore, even running through Rosetta. (It could be
just us since there are a multitude of ways to have a system set up.) Ultimatte replied to us
that until Adobe completes the switch to universal, Ultimatte will not be making any changes
to the software. Just wondering if you have found some work-arounds.

Larry replies: Several readers have strongly recommended DV Garage's DV Matte Pro for chroma-key
work. If Ultimatte is dragging their feet to update their software, check this out instead.

[Gototop]

Speed-Changing Digital Stills
John Warner writes:

A quick question for you. | have a 20 second time lapse of the Asheville Skyline shot on high
resolution digital and now converted to a quicktime movie. The sequence goes from late
afternoon thru dusk. The issue is to speed up the sequence through late afternoon but to
slow down and linger on the dusk and night footage (which is actually rather short). Would
you do this in After Effects with keyframing? Or Final Cut with the Speed control and easy in
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easy out? Or is there a way to do this in Motion? I've done the initial work in Motion.

Larry replies: First, | don't know After Effects well enough to give you good guidance about that application.
As for Motion, its time-remapping tools are best not discussed in public. So, that leaves Final Cut.

You have two options: manipulating the digital stills, manipulating the resulting QuickTime movie.

If you can easily remove stills you can speed up the daylight sequence manually -- say, remove every
second, third, or fourth still. This works great, but is really low-tech.

You can use the time-remap tool in Final Cut but it is very hard to get precise results. (I've even heard
Apple describe this feature as "quirky.") Bezier curves can help, but only if you have a LOT of images.
Otherwise, there won't be enough material for the Bezier curves to work with.

In reviewing my tutorial library, | discover | haven't written a tutorial on how to do a variable speed change.
I'll add that to my list for the future.

[Gototop]

Image Gamma Issues
Paul Fiore writes:

| have been running into a Final Cut issue lately | was hoping you could shed some light on.
When ever | bring Photoshop files into basically any timeline it shows a green render bar.
When | render it (usually for 10 bit uncompressed timelines) the images lightens slightly.
This makes my Clients Angry..haha. Any thoughts on how to avoid this?

Larry replies: Paul, digital video uses a different color space (YCrCb) than the computer (RGB). YCrCb (the
new version of YUV) is more restrictive than RGB, which means you can create colors on the computer
than can not be reproduced in video. Also, YCrCb uses a different gamma (gray scale) setting than the
computer. So, images that look perfect on the computer will look lighter on video, with the potential for a
color shift. Video images, seen on the computer, will look darker.

The ONLY way to make sure your images are correct is to look at them on a video monitor. The computer
should never be used to make final color decisions -- it will never be accurate.

[Gototop]

XML Woes
Rick Lavon writes:

Here is a problem I'm not sure how to solve.



| do a weekly news shows that has a multi-layer timeline with lots of graphics and clips. My
thought was to do future rough cuts at home and bring it in to work to fine tune it to speed up
production. | made copies of everything, brought it home and did a cut. | exported the
sequence via XML and brought it into work. What happened was that when | imported the
sequence, the XML had stripped all the GX and non-tape media of their extensions, like .
mov, .aiff, .png, etc. Now when I try and relink them, it's causing all sorts of problems
because of the missing extensions. The clips on the timeline all have the proper extensions,
but in the reconnect media box, they disappear and have an "unspecified path" for offline
files. Any ideas?

Larry replies: Rick, I'm clueless. Let's see if any of our readers have some ideas.

[Gototop]

Problems with Dissolves
Dave Victorson writes:

Larry, | can apply a “Cross Dissolve” or other video transition between multi-clip edits with
out doing anything special. With single camera standard clips | need to add a “freeze frame”
and then apply the edit to the freeze frames. The transitions won’'t work on the standard clips.

Larry replies: The transition is working perfectly. What's missing is an understanding of "handles.” In order
to have an dissolve you need extra video before the In and after the Out on both clips. Seeing as a
multiclip edit has lots of handles, the dissolve works perfectly. A dissolve works perfectly on two individual
clips, provided you are not using the entire clip.

However, from your description, you are using every frame of one or both of your clips. In which case, you
don't have enough extra video (or handles) outside the In or Out to create your transition -- which is why
you need to create still frames.

Dave responds:

Got it. Instead of creating a subclip in the viewer and saving it in the browser | should drag or
insert it into the timeline directly from the viewer where it will have the handles.

Larry replies: Yup. Using an entire subclip means you have no handles. It is better, in this case, to first set
the In and the Out to give you some space before and after, then edit that clip into your sequence.

[Gototop]

Archiving to Tape
Colin Burberry writes:

| have been reading with interest the discussions on archiving projects to tape or DVD. |



have yet to experience the need to restore or recreate a project that has “disappeared”, or
the original lost. Is it effective to lay off a project to tape?

Larry replies: Is it effective? Yes, as the material is no longer stored on your hard disk. However, simply
laying off the project to tape removes all handles as well as any media you captured but did not use. Still,
laying your final project off to tape is a good way to protect your master sequence.

[Gototop]

Backing-up to Tape
Nate Hubbard writes:

As I've recently had bad DVDs and FW 800 drive failures when trying to restore backed up
date. I've heard that the most reliable storage option is tape backup. Any recommendations
(and, of course, opinions)

Larry replies: The industry standard is Quantum -- their SDLT-600a is designed to work with the Mac.
Another good manufacturer is Exabyte. Finally, Sony recently introduced a lower-cost DLT drive, but in

checking on the web, it appears this is simply a rebranded Quantum drive.

By the way, the prices on the SDLT-600a drive have fallen dramatically. Six months ago, it was north of
$8,000. In a search tonight on the web, it was between $2,100 and $2,750.

My hope is that by NAB this spring, we will see more cost-effective backup solutions. But as of now, the
pickings are slim.

[Gototop]

More on Backups
David Black writes:

Larry, | spent quite a bit of time looking into techniques for archiving and moving my files to
another computer and | am not sure what is the best method.

What | want to do is to archive my project on DVD and take it to work and edit it with my new
Magic Bullet Colorista plug-in. Now, Colorista would be a very cool topic to talk about in your
newsletter. | am sure you are familiar with Magic Bullet from Red Giant Software.

Larry replies: Thanks for writing. Sadly, while your question is easy, the answer is not.

Video files are HUGE -- WAAAAAY beyond the capacity of today's DVDs to hold. (An hour of DV media
requires 13 GB to store. A DVD only holds 4.3 GB.)


http://www.quantum.com/Products/TapeDrives/DLT/SDLT600A/Index.aspx
http://www.exabyte.com/products/index.cfm

That said, one way to move files back and forth is to store your files on an external SATA or FireWire hard
drive. Then, simply carry the files back and forth on the hard drive. This requires pointing your scratch disk
to the external drive, and capturing, or copying media to that drive. The only real problem to this is that an
external FireWire drive is a fraction of the speed of your internal MacPro hard disks -- still fast enough, but
slower.

Simply copying the project folder isn't enough -- it only holds pointers to the data, not the actual data itself.
You will need to store BOTH the project files and media on the hard drive you are carrying back and forth.

[Gototop]

One Last Thought on Backup

| was reading the Dec. 27 issue of DI Studio, an on-line newsletter which focuses on the high-end of
editing. In it they had an interview with Ray Feeney, founder of RFX and Chairman of the Academy's

Science and Technology Council. Ray made an interesting comment which serves to close this section on
archiving:

"The ideal archival mechanism is the “born archival.” Film is that. As soon as it's processed,
it's in an archival form. You don’t have to dupe it or make decisions about what to keep or
what not to keep.

"Today, you have to make a conscious decision of what to put away and it requires a copy
step to be archival. The ideal situation would be if digital capture on the set were recorded in
some manner that was archive-able without having to go through additional steps. But
there’s nothing like that on the horizon at the moment."

[Gototop]

Working with Stills in HD
Henrik Bjorlin, from Stockholm, writes:

First | have to thank you for all the help you have already provided concerning stills, through
articles about aspect ratio etc.

I'm basically working with stills making multi-image shows (Watch out, Keynote, PPT etc.).
Lately I have started using FCP for this purpose (commercials, PAL 720X576).

Stills of course look great in HD, so now | want to do it in HD. But I'm getting desperate after
surfing forums for answers on the following without getting a single clue.

What settings should I use, if | want to output to full HD? | am not capturing any media
through a cam or a deck. | simply import the stills. | have actually used jpeg. Not so heavy.
Maybe there is a better format?


http://www.studiodaily.com/studiomonthly/distudio_signup.html

| prepare the stills in 1920X1080 in 300-dpi (PhotoShop preset for HDTV). If | want to pan a
little into them what size would you recommend?

| have tried to create settings of my own: HDV 1080i50, 25-fps, anamorphic on. Device
Control is set to non-controllable. Capture preset to HDV. | don't know how well this will
work. But | get a strange phenomena | don't understand. When | upload a pic into the viewer
it's like a semi-opaque red filter in front. In the canvas window it looks normal though. This
must mean something | just don't know what?

| plan to output the final product to HDCAM at a "real" production house. Will uncompressed
10 bit QuickTime work?

| work on a iMac PowerPC G5 and 2Ghz processor, 1.5 BG DDR SDRAM, Mac os X 10.4.8
and my scratch is a Maxtor 300Gb.

If I understand correctly what | have read about the different HD formats, all the current
available settings in FCP is compressed one way or another. Is it not possible to edit full HD
material on desktop computers yet?

Larry replies: Henrik, thanks for sending such a great question and for the kind words.

First, avoid HDV for this project like the plague. Here's an article that explains why.

Second, truly uncompressed HD has a data rate in excess of 125 MB/second -- far too much for a FireWire
RAID or hard disk. Unfortunately, your iMac has limited expansion options. My first recommendation was to
add a high-end SATA RAID (150 - 200 MB/second) or Fibre Channel (220 - 440 MB/second) which would
be enough to support uncompressed HDCAM or HDCAM SR HD. However, the iMac makes this not
possible.

So, your best option is to work in DVCProHD -- a 15 MB/second format that can be supported on a
FireWire RAID and, using a capture card, output later to HDCAM.

As for image size, don't work at 300 dpi -- it's too big for Final Cut. Use 72 dpi instead.

If you have an image you are NOT moving within, create it at 1920 x 1080. If you are moving within an
image, use 3840 x 2160 x 72 dpi. Larger images are NOT friendly to Final Cut, which is expecting video
resolutions, not PhotoShop resolutions.

Also, more RAM will help, if your iMac supports it, up to 4 GB.

Finally, set your Final Cut Easy Setup to DVCProHD 1080i/50. You don't need to worry about interlacing,
as all your images are stills. They won't show interlace artifacts.

Good luck with your project!

[Gototop]

Working with 8-mm Footage


http://www.larryjordan.biz/articles/lj_hdv_learn.html

Joan Allisen writes:
| wanted to tell you that | really enjoyed and learned a lot at your seminar in NY. Thank you!

| shoot with a Sony VX 2000 and was wondering what filter | could use to soften the picture
a little. I also have been doing personal histories and am working with 8-mm film home
movies and was wondering if | should use a flicker filter to make it a little less fuzzy... |
understand it will get more grainy the bigger the screen. | just want to be able to tell my client
who was a little concerned that there is nothing else | can do. It obviously looks better on my
smaller monitor.

Larry replies: To improve the look of your on-camera interviews, try using a 1/4 Black ProMist filter in front
of your camera. You could go so far as a 1/2 Black ProMist. You can buy them from Tiffen or Schneider.

As for the 8 mm footage, the best way to capture it is thru a telecine process at a post-production facility --
they can improve the image quality to be significantly better than simply shooting images from a screen.

Wrap-Up
Well, that's it for another issue. Please take a few minutes and:

. Regqister for one of my England or Ireland seminars

. Subscribe to Edit Well

. Take two minutes and complete our survey

. Visit our story and buy a DVD or keyboard cover, or two.

Your support for our seminars and products keeps our website, and this newsletter, free.

Thanks for all your comments and questions. | love hearing from you because when you share your ideas
and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter!

Email:

Go



http://www.tiffen.com/tiffen_filters.html
http://www.schneideroptics.com/
http://www.larryjordan.biz/sem/2007_uk.html
http://www.peachpit.com/editwell
http://www.surveymonkey.com/s.asp?u=266613071547
http://www.larryjordan.biz/store/index.html
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the
variety of possible system and software configurations, the author assumes no liability in case things go
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective
owners and are mentioned here for editorial purposes only.
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